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Your Best STL Learning Tools

Welcome to your Best STL training course.

As part of your training, we provide you with the following tools and resources to support and enhance your learning experience.

Thank you for choosing Best STL.
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Best Training reserves the right to revise this publication and make changes from time to time in its content without notice.
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Quick reference: Excel 2007 shortcuts

CTRL combination shortcut keys

	Key
	Description

	CTRL+SHIFT+(
	Unhides any hidden rows within the selection.

	CTRL+SHIFT+)
	Unhides any hidden columns within the selection.

	CTRL+SHIFT+&
	Applies the outline border to the selected cells.

	CTRL+SHIFT_
	Removes the outline border from the selected cells.

	CTRL+SHIFT+~
	Applies the General number format.

	CTRL+SHIFT+$
	Applies the Currency format with two decimal places (negative numbers in parentheses).

	CTRL+SHIFT+%
	Applies the Percentage format with no decimal places.

	CTRL+SHIFT+^
	Applies the Exponential number format with two decimal places.

	CTRL+SHIFT+#
	Applies the Date format with the day, month, and year.

	CTRL+SHIFT+@
	Applies the Time format with the hour and minute, and AM or PM.

	CTRL+SHIFT+!
	Applies the Number format with two decimal places, thousands separator, and minus sign (-) for negative values.

	CTRL+SHIFT+*
	Selects the current region around the active cell (the data area enclosed by blank rows and blank columns).

In a PivotTable, it selects the entire PivotTable report.

	CTRL+SHIFT+:
	Enters the current time.

	CTRL+SHIFT+"
	Copies the value from the cell above the active cell into the cell or the Formula Bar.

	CTRL+SHIFT+Plus (+)
	Displays the Insert dialogue box to insert blank cells.

	CTRL+Minus (-)
	Displays the Delete dialogue box to delete the selected cells.

	CTRL+;
	Enters the current date.

	CTRL+`
	Alternates between displaying cell values and displaying formulas in the worksheet.

	CTRL+'
	Copies a formula from the cell above the active cell into the cell or the Formula Bar.

	CTRL+1
	Displays the Format Cells dialogue box.

	CTRL+2
	Applies or removes bold formatting.

	CTRL+3
	Applies or removes italic formatting.

	CTRL+4
	Applies or removes underlining.

	CTRL+5
	Applies or removes strikethrough.

	CTRL+6
	Alternates between hiding objects, displaying objects, and displaying placeholders for objects.

	
	

	CTRL+8
	Displays or hides the outline symbols.

	CTRL+9
	Hides the selected rows.

	CTRL+0
	Hides the selected columns.

	CTRL+A
	Selects the entire worksheet. 

If the worksheet contains data, CTRL+A selects the current region. Pressing CTRL+A a second time selects the current region and its summary rows. Pressing CTRL+A a third time selects the entire worksheet.

When the insertion point is to the right of a function name in a formula, displays the Function Arguments dialogue box.

CTRL+SHIFT+A inserts the argument names and parentheses when the insertion point is to the right of a function name in a formula.

	CTRL+B
	Applies or removes bold formatting.

	CTRL+C
	Copies the selected cells. 

CTRL+C followed by another CTRL+C displays the Clipboard.

	CTRL+D
	Uses the Fill Down command to copy the contents and format of the topmost cell of a selected range into the cells below.

	
	

	CTRL+F
	Displays the Find and Replace dialogue box, with the Find tab selected. 

SHIFT+F5 also displays this tab, while SHIFT+F4 repeats the last Find action.

CTRL+SHIFT+F opens the Format Cells dialogue box with the Font tab selected.

	CTRL+G 
	Displays the Go To dialogue box. 

F5 also displays this dialogue box.

	CTRL+H 
	Displays the Find and Replace dialogue box, with the Replace tab selected.

	CTRL+I
	Applies or removes italic formatting.

	CTRL+K
	Displays the Insert Hyperlink dialogue box for new hyperlinks or the Edit Hyperlink dialogue box for selected existing hyperlinks.

	CTRL+N 
	Creates a new, blank workbook.

	CTRL+O 
	Displays the Open dialogue box to open or find a file.

CTRL+SHIFT+O selects all cells that contain comments.

	CTRL+P
	Displays the Print dialogue box.

CTRL+SHIFT+P opens the Format Cells dialogue box with the Font tab selected.

	CTRL+R
	Uses the Fill Right command to copy the contents and format of the leftmost cell of a selected range into the cells to the right.

	CTRL+S
	Saves the active file with its current file name, location, and file format.

	CTRL+T
	Displays the Create Table dialogue box.

	CTRL+U
	Applies or removes underlining.

CTRL+SHIFT+U switches between expanding and collapsing of the formula bar. 

	CTRL+V 
	Inserts the contents of the Clipboard at the insertion point and replaces any selection. Available only after you have cut or copied an object, text, or cell contents.

CTRL+ALT+V displays the Paste Special dialogue box. Available only after you have cut or copied an object, text, or cell contents on a worksheet or in another program.

	CTRL+W
	Closes the selected workbook window.

	CTRL+X 
	Cuts the selected cells.

	CTRL+Y
	Repeats the last command or action, if possible.

	CTRL+Z
	Uses the Undo command to reverse the last command or to delete the last entry that you typed.

CTRL+SHIFT+Z uses the Undo or Redo command to reverse or restore the last automatic correction when AutoCorrect Smart Tags are displayed.


Function keys

	Key
	Description

	F1
	Displays the Microsoft Office Excel Help task pane.

CTRL+F1 displays or hides the Ribbon, a component of the Microsoft Office Fluent user interface.

ALT+F1 creates a chart of the data in the current range.

ALT+SHIFT+F1 inserts a new worksheet.

	F2
	Edits the active cell and positions the insertion point at the end of the cell contents. It also moves the insertion point into the Formula Bar when editing in a cell is turned off.

SHIFT+F2 adds or edits a cell comment.

CTRL+F2 displays the Print Preview window.

	F3
	Displays the Paste Name dialogue box.

SHIFT+F3 displays the Insert Function dialogue box.

	F4
	Repeats the last command or action, if possible.

CTRL+F4 closes the selected workbook window.

	F5
	Displays the Go To dialogue box.

CTRL+F5 restores the window size of the selected workbook window.

	F6
	Switches between the worksheet, Ribbon, task pane, and Zoom controls. In a worksheet that has been split (View menu, Manage This Window, Freeze Panes, Split Window command), F6 includes the split panes when switching between panes and the Ribbon area. 

SHIFT+F6 switches between the worksheet, Zoom controls, task pane, and Ribbon.

CTRL+F6 switches to the next workbook window when more than one workbook window is open.

	F7
	Displays the Spelling dialogue box to check spelling in the active worksheet or selected range.

CTRL+F7 performs the Move command on the workbook window when it is not maximized. Use the arrow keys to move the window, and when finished press ENTER, or ESC to cancel.

	F8
	Turns extend mode on or off. In extend mode, Extended Selection appears in the status line, and the arrow keys extend the selection.

SHIFT+F8 enables you to add a nonadjacent cell or range to a selection of cells by using the arrow keys.

CTRL+F8 performs the Size command (on the Control menu for the workbook window) when a workbook is not maximized.

ALT+F8 displays the Macro dialogue box to create, run, edit, or delete a macro.

	F9
	Calculates all worksheets in all open workbooks.

SHIFT+F9 calculates the active worksheet.

CTRL+ALT+F9 calculates all worksheets in all open workbooks, regardless of whether they have changed since the last calculation.

CTRL+ALT+SHIFT+F9 rechecks dependent formulas, and then calculates all cells in all open workbooks, including cells not marked as needing to be calculated.

CTRL+F9 minimizes a workbook window to an icon.

	F10
	Turns key tips on or off.

SHIFT+F10 displays the shortcut menu for a selected item.

ALT+SHIFT+F10 displays the menu or message for a smart tag. If more than one smart tag is present, it switches to the next smart tag and displays its menu or message.

CTRL+F10 maximizes or restores the selected workbook window.

	F11
	Creates a chart of the data in the current range.

SHIFT+F11 inserts a new worksheet.

ALT+F11 opens the Microsoft Visual Basic Editor, in which you can create a macro by using Visual Basic for Applications (VBA).

	F12
	Displays the Save As dialogue box.


Other useful shortcut keys

	Key
	Description

	ARROW KEYS
	Move one cell up, down, left, or right in a worksheet. 

CTRL+ARROW KEY moves to the edge of the current data region (data region: A range of cells that contains data and that is bounded by empty cells or datasheet borders.) in a worksheet.

SHIFT+ARROW KEY extends the selection of cells by one cell.

CTRL+SHIFT+ARROW KEY extends the selection of cells to the last nonblank cell in the same column or row as the active cell, or if the next cell is blank, extends the selection to the next nonblank cell.

LEFT ARROW or RIGHT ARROW selects the tab to the left or right when the Ribbon is selected. When a submenu is open or selected, these arrow keys switch between the main menu and the submenu. When a Ribbon tab is selected, these keys navigate the tab buttons.

DOWN ARROW or UP ARROW selects the next or previous command when a menu or submenu is open. When a Ribbon tab is selected, these keys navigate up or down the tab group.

In a dialogue box, arrow keys move between options in an open drop-down list, or between options in a group of options.

DOWN ARROW or ALT+DOWN ARROW opens a selected drop-down list.

	BACKSPACE
	Deletes one character to the left in the Formula Bar.

Also clears the content of the active cell.

In cell editing mode, it deletes the character to the left of the insertion point.

	DELETE
	Removes the cell contents (data and formulas) from selected cells without affecting cell formats or comments. 

In cell editing mode, it deletes the character to the right of the insertion point. 

	END
	Moves to the cell in the lower-right corner of the window when SCROLL LOCK is turned on.

Also selects the last command on the menu when a menu or submenu is visible.

CTRL+END moves to the last cell on a worksheet, in the lowest used row of the rightmost used column. If the cursor is in the formula bar, CTRL+END moves the cursor to the end of the text. 

CTRL+SHIFT+END extends the selection of cells to the last used cell on the worksheet (lower-right corner). If the cursor is in the formula bar, CTRL+SHIFT+END selects all text in the formula bar from the cursor position to the end—this does not affect the height of the formula bar. 

	ENTER
	Completes a cell entry from the cell or the Formula Bar, and selects the cell below (by default).

In a data form, it moves to the first field in the next record.

Opens a selected menu (press F10 to activate the menu bar) or performs the action for a selected command.

In a dialogue box, it performs the action for the default command button in the dialogue box (the button with the bold outline, often the OK button).

ALT+ENTER starts a new line in the same cell.

CTRL+ENTER fills the selected cell range with the current entry.

SHIFT+ENTER completes a cell entry and selects the cell above.

	
	

	ESC
	Cancels an entry in the cell or Formula Bar. 

Closes an open menu or submenu, dialogue box, or message window.

It also closes full screen mode when this mode has been applied, and returns to normal screen mode to display the Ribbon and status bar again.

	HOME
	Moves to the beginning of a row in a worksheet.

Moves to the cell in the upper-left corner of the window when SCROLL LOCK is turned on.

Selects the first command on the menu when a menu or submenu is visible.

CTRL+HOME moves to the beginning of a worksheet.

CTRL+SHIFT+HOME extends the selection of cells to the beginning of the worksheet.

	PAGE DOWN
	Moves one screen down in a worksheet. 

ALT+PAGE DOWN moves one screen to the right in a worksheet.

CTRL+PAGE DOWN moves to the next sheet in a workbook.

CTRL+SHIFT+PAGE DOWN selects the current and next sheet in a workbook.

	PAGE UP
	Moves one screen up in a worksheet.

ALT+PAGE UP moves one screen to the left in a worksheet.

CTRL+PAGE UP moves to the previous sheet in a workbook.

CTRL+SHIFT+PAGE UP selects the current and previous sheet in a workbook.

	SPACEBAR
	In a dialogue box, performs the action for the selected button, or selects or clears a check box.

CTRL+SPACEBAR selects an entire column in a worksheet.

SHIFT+SPACEBAR selects an entire row in a worksheet.

CTRL+SHIFT+SPACEBAR selects the entire worksheet. 

· If the worksheet contains data, CTRL+SHIFT+SPACEBAR selects the current region. Pressing CTRL+SHIFT+SPACEBAR a second time selects the current region and its summary rows. Pressing CTRL+SHIFT+SPACEBAR a third time selects the entire worksheet. 

· When an object is selected, CTRL+SHIFT+SPACEBAR selects all objects on a worksheet.

ALT+SPACEBAR displays the Control menu for the Microsoft Office Excel window.

	TAB
	Moves one cell to the right in a worksheet.

Moves between unlocked cells in a protected worksheet.

Moves to the next option or option group in a dialogue box.

SHIFT+TAB moves to the previous cell in a worksheet or the previous option in a dialogue box.

CTRL+TAB switches to the next tab in dialogue box.

CTRL+SHIFT+TAB switches to the previous tab in a dialogue box.


What’s New in Excel 2007

One of the major differences between Excel 2007 and its predecessors is the new graphical user interface. The new user interface does not rely on multiple tool bars and menus; instead it offers a cleaner, more intuitive, Ribbon-based layout. 
The Quick Access Toolbar
The Quick Access Toolbar is located in the upper left of the Excel 2007 screen, just to the right of the Office menu button. By default, the Quick Access Toolbar holds three buttons (Save, Undo and Redo).
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Adding Buttons

To add a button to the Quick Access Toolbar:

· Right-click the button you wish to add to the toolbar

· Click the Add to Quick Access Toolbar option.
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If you wish, you can add a group of buttons to the Quick Access Toolbar at once.

To do this:

· Right-click on the word that defines the group (such as Font).
· Click the Add to Quick Access Toolbar option to add the button group.
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Removing Buttons

It is very easy to remove a button or a button group from the Quick Access Toolbar.

· Right-click on button

· Click the Remove from Quick Access Toolbar option. 
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Customising the Toolbar

To customise the Quick Access Toolbar:

· Click on the small down-pointing arrow at the right of the Quick Access Toolbar.

 SHAPE  \* MERGEFORMAT 



· Click the More Commands option, to display the Excel Options screen.

To add a button:

Select a command from the list on the left and then click the Add button, the command or option in question will be added to the Quick Access Toolbar when you click OK.

To remove a button:

Select a command from the list on the right (the buttons that are currently on the Quick Access Toolbar) and then click the Remove button, the button in question will be removed from the Quick Access Toolbar when you click OK.

At the far right of the Excel Options screen you will see two arrow buttons.
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You can use these arrows to shift the position of buttons currently on the toolbar. 
If you click the Reset button near the bottom of the Excel Options screen, the Quick Access Toolbar will be reset to its default configuration.

Finally, you can choose to display the Quick Access Toolbar at the bottom of the Ribbon instead of the top using the Quick Access Toolbar menu.

Office Button menu

The Office button menu contains a lot of features that resided within the File menu in previous versions of Excel.
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Excel 2007 Ribbons
The most notable feature of the new Excel 2007 interface is the Ribbon format. By default Excel has seven Ribbons available through tabs. These Ribbons are:

· The Home Ribbon
· The Insert Ribbon
· The Page Layout Ribbon
· The Formulas Ribbon
· The Data Ribbon

· The Review Ribbon

· The View Ribbon
Where do I find?...

Here is where you will find some of the more commonly used features of Excel.

	I want to….
	Ribbon/Button
	Group/Command

	Add numbers using AutoSum
	Home

or

Formulas
	Editing 

Function Library

	Adjust the zoom
	View

or
	Zoom

	
	Use Zoom slider (bottom right of screen)

	Apply conditional formatting
	Home
	Styles

	Change Excel’s settings
	Office Button
	Excel Options

	Create a chart
	Insert
	Charts

	Create a header or footer
	Insert
	Text

	Create a macro
	Developer
	Code

	Create a pivot table
	Insert
	Pivot Table

	Filter my data
	Home

or

Data
	Editing

Sort & Filter

	Format numbers in my spreadsheet
	Home
	Number

	Hide columns or rows
	Home
	Cells – Format

	Import external data into Excel
	Data
	Get External Data

	Open a file
	Office Button
	Open

	Print a file
	Office Button
	Print

	Save a file
	Office Button
	Save

	Sort my data
	Home

or

Data
	Editing

Sort & Filter

	Undo/Redo
	Quick Access Toolbar

	Use an Excel function
	Formulas
	Function Library

	Use Page Setup features
	Page Layout
	Page Setup

	Use Print Preview
	Office Button
	Print


Access Keys

Access keys give you access to the Ribbon. They relate directly to the tabs, commands, and other things that you see on the screen. You use access keys by pressing the ALT key followed by another key or a sequence of other keys.
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Contextual tabs

Certain sets of commands are only relevant when objects of a particular type are being edited. For example, the commands for editing a chart are not relevant until a chart appears in a spreadsheet and the user is focusing on modifying it.

Clicking on a chart causes a contextual tab to appear with commands used for chart editing (see below). Contextual tabs only appear when they are needed and make it much easier to find and use the commands needed for the operation at hand.
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Live Preview

Live Preview is a new technology that shows the results of applying an editing or formatting change as the user moves the pointer over various formatting options presented on a Ribbon. 
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Themes

The Themes button group allows you to change the colours, fonts, and other visual effects associated with a given Excel 2007 theme. You can find the Themes group on the Page Layout tab.
Unit 1: Using Logical Functions

In this unit, you will learn how to:
· Define range names and use names in formulas

· Identify and apply Excel’s logical functions, IF, AND, OR
· Create nested functions by combining logical functions in a formula
Working with Names and Ranges

Working with numbers isn’t always easy. A complex formula involving several cell ranges can be difficult to understand. Individual cells that contain important data can be hard to find on a large worksheet. Cell references like D5:D22 or A33:C33 are somewhat abstract, and don’t really communicate anything about the data they contain.

In Excel, you can create meaningful names for cells or ranges that can be used to overcome these difficulties. 

What Are Range Names?

Range names are meaningful character strings that you can assign to individual cells or cell ranges. You can use a range name practically anywhere you can use a cell or range reference. The advantage of using names comes from the fact that a name, like Employees, is more meaningful and less abstract than a reference like C2:C55. Also, named ranges are by default absolute, so if you copy or AutoFill a formula using named ranges, it will maintain its original cell references. 
Defining and Using Range Names

To define a range name:

· Select either a cell or cell range
· On the Formulas Ribbon, choose the Define Name button from the Defined Names group 
· To name your range, type a name in the top text field and click OK. The Scope refers to the parts of the workbook where your named range will be valid.

Another way to name a cell or range is to:

· Select the cell or range of cells
· Click in the Name Box to the left of the formula bar and Type the name
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· Press Enter.
Note: Excel will not accept spaces between words in the names you choose. For example, “newrange” or “newRange” or “new_Range”would be acceptable, but “New Range” would not.

Once you have defined your named ranges, you can use them in formulas and functions just as you would a regular cell or range reference. 

Using Logical Functions

Excel 2007’s logical functions are:

	· AND

· OR

· IF

· NO
	· FALSE

· TRUE

· IFERROR




These logical functions are important when doing advanced work in Excel because they can help you control the behavior of your worksheets based on specific logical conditions.

This unit will focus on the use of the logical functions IF, AND, OR
Using the Function Library

Excel 2007 contains an extensive library of functions that you can call upon to help you solve problems. These tools are available in the Function Library button group, on the Formulas ribbon. 
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The first and largest button is Insert Function. This button will open a dialog allowing you to search for and insert hundreds of functions. 

You can also click the small fx button next to the formula bar to display the Insert Function box.


[image: image15]
Manually entering a function
If you know which function you wish to use, you can enter a function into a worksheet by inputting it manually (i.e. by typing the function directly into a cell).

When you do this in Excel 2007, a screen tip will appear with the possible functions that correspond with the letters of the function name you have entered.

For example, if you type =IF into a cell the following appears.
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Once you have selected the function you wish to use, continue by typing in a left bracket, which will cause the function syntax to display in another screen tip.
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Continue to enter all the arguments required for the function to give you a result, ensuring you type a comma between each argument.

[image: image18.png](AL<=100, A1%5, C3%2)

TFlogical.test, valu





Press Enter to display the result.

The IF function
Excel’s IF function can often prove to be very useful. You can use this function to branch to different values or actions depending on a specified condition. The structure of an If function is as follows: IF(logical test, value if true, value if false) 
The AND Function
The AND function will return TRUE if all of its arguments are true. If one argument is false, the AND function will return FALSE. For example, the logical statement 1<10 is true and the statement 2>1 is also true. As a result, the compound statement 1<10 AND 2>1 is TRUE, because both of the statements that are being joined by AND are true. The following image demonstrates this in Excel.
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You can have as many as 255 logical arguments to an Excel AND function. 
The following table (often referred to as a truth table) may help you understand the AND function. In the last column of the truth table, you will see the value returned by the function, according to the corresponding values of the function arguments.

	A
	B
	AND(a, b)

	True
	False
	False

	False
	True
	False

	True
	True
	True

	False
	False
	False


The OR Function
The logical OR function will return TRUE if one or more of the arguments to the function are true. For instance, the logical statement 1<10 OR 2<1 is true, since 1 is less than 10. It does not matter that the statement 2<1 is false, because you have a choice of either 1<10 OR 2<1 to make the compound statement true. If one or both of the arguments is true, the overall OR statement will also be true.

[image: image20.png]



You can have as many as 255 logical arguments to an Excel OR function. 
Here is a truth table for the OR function.

	A
	B
	OR(A,B)

	True
	False
	True

	False
	True
	True

	True
	True
	True

	False
	False
	False


Working with Nested Functions
In Excel, you can actually place (or nest) a function within a function. This can be extremely useful for a wide variety of situations. Excel allows up to 64 nested functions.
Nested IF functions
[image: image72.jpg]


The IF function is ideal for making choices based on logical tests. Furthermore, you can nest IF functions one inside another.
=IF(A1=10,100,IF(A1=5,200,0))


In the case of this IF function, if the value in cell A1 is 10 the function will return 100. If the value in A1 is not 10, the function will test if the value in A1 is 5. If the value in A1 is 5, the function will return 200. If it is not 5 (and also not 100) the function will return 0.
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When you nest logical functions, you must make sure that the number of closing parenthesis matches the number of opening parenthesis used in the function. If you count the parenthesis in the function from the image above, you will see two opening, and two closing parenthesis.

Applying Logical Functions
Nested functions can also be created using the IF and OR functions together; or the IF and AND functions together.

For example:

	Function combination
	Why is this useful?


	IF function + AND function
	Value is returned if BOTH conditions are TRUE 

	IF function + OR function
	Value is returned if ONE of the conditions is TRUE


Unit 1 Practice Activity

1. Open the file Grade allocation.xlsx in the Practice Files folder
2. We wish to determine whether a student qualifies for bonus marks.  To qualify they must meet all the following criteria;

· student marks allocated in Test 2 exceed 18 

· student marks allocated in Test 4 exceed 19
· the average grade of the student is greater than 12

Use the AND function to verify that the three conditions stated above in step (2) have all been met. The AND function will generate a TRUE response if all three conditions have all been met.

3. Place cursor in cell H2, and create a formula using the AND function to determine if Anna is eligible for a bonus.

4. Copy this formula down for all students.

5. Create, in the column titled “Bonus Marks Awarded”, an IF calculation to show 10 bonus marks awarded if it is TRUE they qualify for a bonus, and to show the text “None”, if they do not qualify for a bonus.  

6. Copy this formula down for all students

7. Create, in the column titled “At Least One Condition Met”, by using the OR function, a calculation to determine if at least one of the conditions in step (2) has been met by any students.

8. Copy this formula down for all students.

9. Create, in the column titled “Total”, a calculation to determine a student marks total inclusive of bonus. 

10. Copy this formula down for all students.

11. Create, in the column titled “Final grade”, a nested IF calculation to determine a student’s final grade.  Please use the “Grade table” for information on grading levels.  

12. Copy this formula down for all students 

13. Save and close Grade allocation.
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Unit 2: Working with Lookup Functions

In this unit, you will learn how to:

· Identify and use the VLOOKUP function

· Identify and use the HLOOKUP function

Excel 2007 provides two lookup functions that you can use to quickly retrieve information from data in a table. The functions are called HLOOKUP (horizontal lookup) and VLOOKUP (vertical lookup). 
The VLOOKUP function will look in the leftmost column of a table for a value you specify. When it finds the value you specified, it will return a value that is located in the same row, a specified number of columns into the table. It is called VLOOKUP because it looks vertically down a column for a match, and then retrieves data from across the row.

HLOOKUP is similar, but it will look horizontally across the upper row of your table, and then retrieve data from a column further down. 

Using VLOOKUP to Find Data

The best way to learn how lookup functions work is to look at an example. Here we have a table of ticket prices for flights to different countries. To simplify matters, the data range for the table has been given a defined name (Price) that can be used in functions and formulas. 
If we activate cell F1 and enter =VLOOKUP("England",Price,2) into the formula bar, cell F1 will show the value 550.
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The lookup function looked vertically down the leftmost column of the lookup table (Price) until it found a match for the text string “England.” The function then returned the value that is in the second (2) column of the table, from the row where the match was found. You should notice that England, Price, and 2 are the exact arguments used in the function.

The arguments for the lookup function are:
VLOOKUP
· Value to match, from the left most column of the lookup table

· Lookup table name or range

· Number of the column in the table containing the relevant data

· TRUE or FALSE
For the example shown above, the true or false argument was left out. The relevance of the true or false argument in the VLOOKUP function will be discussed shortly.

HLOOKUP is the same as VLOOKUP, except that it looks across rows for a match rather than down columns. To use HLOOKUP, the lookup table would be arranged in this way.
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Since Excel is designed with more cells in the vertical direction than in the horizontal direction, and because a vertical table design is more intuitive for most people, VLOOKUP is generally used more often than HLOOKUP. 

How to Find an Exact Match with VLOOKUP

As mentioned briefly before, the VLOOKUP function can take a final argument of either TRUE or FALSE. If you specify this final argument as FALSE, VLOOKUP will search for an exact match in the lookup column (column of identifiers). If it cannot find an exact match, no data will be returned with the error #N/A!
Finding the Closest Match with VLOOKUP

If the final argument in your VLOOKUP function is TRUE, VLOOKUP will search the column of identifiers for the closest match to the search value you enter as the first function argument. The closest match will be the next lowest value to the search value. 

If you omit the final argument in your VLOOKUP function, it will default to TRUE, and search for a closest value if it cannot find an exact match.

If you are using the TRUE argument, the values in the look up column should be sorted in ascending order. Otherwise, you may get unexpected results. 

Unit 2 Practice Activity

1. Open the file Sales Invoice.xlsx in the Practice Files folder
2. Start by selecting cell B16 and use an exact match VLOOKUP to find data on the Product List worksheet to fill in the values for: No. of days
3. Follow the same procedure to find data for the Description, Price Per Unit and Commission by creating exact match VLOOKUP formulas in cells C16 through E16
NB.
Combine the VLOOKUP with an IF statement so that the cells remain empty ("") until a Product Code (A16) is selected.
4. Copy the above formulas down to Row 29.
5. Select the Invoice No. from the drop-down list in cell F3

6. Select the Customer No. from the drop-down list in cell F5

7. Select the Product Code, from the drop-down selection in column A as follows:
a. In Cell A16 select Product Code SAM30
b. In Cell A21 select Product Code H78
c. In Cell A26 select Product Code IT14
NB Only these lines should show data. All the others should remain blank.

Optional

8. Select cell C8 and use an exact match VLOOKUP formula to find data on the Customer List worksheet to fill in the value for the Customer Name. Combine the VLOOKUP with an IF statement so that the cells remain empty ("") until a Product Code (A16) is selected.
9. In cells C9 through C12, create exact match VLOOKUP formulas to find Address1, Address2, Town / City and Postcode.

10. Save the file as My Sales Invoice.xlsx
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Unit 3: Advanced List Management

In this unit, you will learn how to:
· Apply data validation settings to control data entry

· Identify and use database functions to perform calculations using multiple database fields

Validating Your Data

When you have a database set up in Excel, it is important to maintain its integrity. You can help ensure that only the right data goes into your database by setting up data validation rules.

Creating Data Validation Settings
To set up data validation for a cell:

· Select the cell or cell range you wish to apply validation settings to

· Select Data from the Data Tools group, then click the Data Validation button
Settings

· Under the Settings tab, use the Allow drop-down list to select the type of data value that will be permitted in the cell/s. If you choose any option other than “any value,” you will be provided with further options to set criteria and/or limits on the data values.
· The other drop-down lists can be used to set conditions and parameter values.
· If there are other cells with the same validation settings, you can fill the bottom check box to apply the validation changes you have made to all of the cells.
Input Message

· Under the Input Message tab, you will find options to create a message that will appear when the validated cell is selected.
Error Alerts

· Under the Error Alert tab, you will find options to specify an error message if the wrong type of data is entered into the cell.
· Click OK to apply your settings.
Using Database Functions

Database functions allow you to perform operations on an Excel database that involve multiple fields, including counts, averages, or sums. 
Some useful database functions are:
	DSUM
	Used to create total values in a field based on specified criteria

	DAVERAGE 
	Used to average values in a field based on specified criteria

	DCOUNT 
	Counts the cells that contain numbers and meet the specified criteria

	DMAX and DMIN 
	Return the largest and smallest values respectively from records that meet the specified criteria.


All of the database functions use the same argument format: 

=FunctionName(Database range, Field to be returned or calculated, Criteria range).

Creating a Criteria Range

The first step in using a database function is to set up a criteria range. We do this by entering the field headings that we want to use exactly as they are in the original data list.
In the row under the field headings, enter the criteria you want Excel to locate from each of the fields.

Entering the Database Function

To enter the function:

· Activate the cell and click the function (fx) button near the formula bar.

· In the Insert Function dialogue box, choose the database function you wish to use from the database category
· Select your original list/database with your mouse, or enter the range directly into the Database data area.

· In the Field data area enter the heading of the field to be summed/averaged/counted etc. (you can also enter the field cell reference or the column number, counting from the first column of the data area.)
· In the Criteria data area, select the entire criteria range with your mouse.

· Click the OK button.

If you enter a database function directly into the spreadsheet, remember to keep your cell ranges accurate, and put the heading of the field that will be summed, averaged, or otherwise operated on, in quotation marks. 

Unit 3 Practice Activity

1. Open the file Practice_Daily_Sales.xlsx in the Practice Files folder
2. Go to the Data Validation sheet
3. Remove the validation from the cell range F4:F5
4. Reset the validation for Column B as text only (Custom, function ISTEXT)
5. Name cells L3:L5 as My_List
6. Add My_List to a Data Validation List for Column C
7. Use My_List dropdown to change some cells in Column C
8. Go to the sheet Data Functions
9. In cell D6, use a database function to calculate the totals for America sales
10. In cell D7, use a database function to calculate the average for America sales
11. Format the cells D6 and D7 to two decimal places, using the sterling currency
12. Save as My_Practice_Daily_Sales.xlsx and close.
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Unit 4: PivotTables and PivotCharts
In this unit, you will learn how to:
· Create a PivotTable from a list of data
· Modify a PivotTable to change data display

· Create a PivotChart 

· Use external data to create a PivotTable
A major function of any spreadsheet program is to help you derive meaning from your data. An Excel PivotTable is a great tool for getting perspective on, and analysing relationships between, the columns and rows of your worksheet.
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What is a PivotTable?

A PivotTable is a powerful tool for exploring and analysing information. A PivotTable helps you organise and manipulate the raw data in your spreadsheet, giving you insight into patterns or relationships that might not be obvious at first glance.

You can base a PivotTable on data in your current workbook or even external data from another source if you wish. With a PivotTable, you can conveniently drag and drop columns of your data to different areas of the table to examine relationships or trends that may not be obvious in a traditional Excel table or database. 

Preparing Data to Create a PivotTable

Ideally, source data for a PivotTable should be structured like a traditional Excel table or database. The source data should have a row of unique column headings distinguishing the data and there should be no empty columns interspersed within the data. Also, blank rows in a source list or database can limit the usefulness of your PivotTable.

The following image shows a block of contiguous data that is well suited for a PivotTable.
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Notice that there are no empty rows or columns and that every column of data has a unique label.
Creating a PivotTable

To create an Excel 2007 PivotTable:

· Select the range of data that you want to base the table on

· On the Insert Ribbon, Tables group, click the PivotTable button
· When the Create PivotTable dialogue box appears, choose the table or range option, so the PivotTable will be based on the Excel table or range you selected. 
· Once you select your data source, you can then choose to locate your PivotTable in an Existing Worksheet or a New Worksheet. 
· Click OK to create your PivotTable. 
For information on how to create a PivotTable from external data, please see the downloadable reference material.

Adding Fields to the PivotTable

Once your PivotTable appears, you can add information to it by placing checks in the boxes next to the headings in the PivotTable field list or by dragging the fields to the designated areas.
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Creating a PivotTable Frame (Classic PivotTable Layout)
You can also create a PivotTable by creating an empty table frame (also known as a classic layout) and adding and arranging data in the table by dropping and dragging column headings onto the frame.

To create a PivotTable frame:

· Click the PivotTable button on the Insert Ribbon to display the PivotTable dialogue box.

· Follow the same process as described before for creating an Excel 2007 PivotTable. 
· Before adding data to the PivotTable table, right click on it and choose Table Options from the pop up menu
· In the Options box, choose the Display tab and then put a checkmark in the Classic PivotTable Layout box. 

PivotTable areas
To make the best use of your PivotTable, you should understand what the various areas in a PivotTable are for.

You can see by examining an empty PivotTable frame that a PivotTable is broken into four main areas: Page, Data, Row, and Column.


[image: image27]
The Page Field area is ideally suited to column headings (fields) that are used to identify periodic or organisational groupings of the data in your other columns, e.g. month or year column headings.
The Data area provides the underlying context for the rest of the PivotTable. The column heading you choose for the data area of the table normally has numeric values associated with it.
The Row and Column fields are used to categorise the data you want to examine. When you choose column headings to be placed in the row and column fields, you can see how your choices relate to each other in the context of the Data being examined.

Rearranging PivotTable Data

Once a PivotTable has been created, it is easy to rearrange the data if necessary. Note that you must be using the Classic Layout to rearrange data in the way described below.

Here we have a table showing profit by product type across regions.

If we wanted to show sales figures instead of profit figures, you can remove the profit information from the data area by dragging the Sum of Profit heading in the upper left corner of the table out of the table area to drop it anywhere outside the blue table borders.
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You can rearrange any of the categories of data in your table by following this process of dragging headings out of the table and then replacing them with headings from the PivotTable field list.

Hiding and Showing Field Data

You will also notice that the row, column, and page areas of the PivotTable field list have drop-down lists associated with them, indicated by small downward pointing triangles. 
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You can use these drop-down lists to rearrange your data according to specific elements in a given category. 
The PivotTable Tools Ribbon

If you close the PivotTable Field List, you can always get it back by clicking the Field List button on the Options Ribbon. 


[image: image30]
The Options Ribbon and the Design Ribbon will become available whenever you click inside the borders of your PivotTable.
Modifying Calculations and Data Area Display

The default setting for PivotTable calculations is SUM. This means that the totals shown in the Grand Total areas of the PivotTable will be derived from summing the values in the rows and columns.

To modify the way these totals are calculated:

· Right click on the Sum of ‘X’ field in the upper left corner of the PivotTable. 
· Select Value Field Settings from the shortcut menu, then Summarize value field by tab.
· Switch the type of calculation to Count, Average, Max or Min, Product, Standard deviation, or Variance. 
· Click OK.

Please note: The previous discussion has dealt primarily with PivotTable frames, also known as classic PivotTable layouts. For information on how to arrange data in the default Excel 2007 PivotTable layout, please see the downloadable reference material.

Formatting a PivotTable

To format a PivotTable:

· Click on a cell in the PivotTable, and from the PivotTable Tools tab 
· Select the Design Ribbon.
· On the Design Ribbon, click on one of the preset styles in the PivotTable Styles group to quickly apply preset formatting to the table
Refreshing a PivotTable

The data in a PivotTable is not linked directly to the source table or range. Instead, the PivotTable is based on a hidden copy of the source data that is kept in memory by Excel. This means that changes to the original source list or database will not be automatically updated in the PivotTable. If you make changes in the source data, you must refresh the PivotTable to update it.

To refresh a PivotTable:

· Click the Refresh button on the Data Ribbon or on the Options Ribbon; or
· Right click on a cell in the data area of the table and then click the Refresh Data option from the pop up menu.
Creating a PivotChart
To create a chart based on an existing PivotTable:

· Click a cell in the table

· On the Options ribbon, Tools group, click the PivotChart button then select a chart type then click OK. You can select any chart type except XY Scatter, Bubble, or Stock charts.

Or

· On the Insert ribbon, Charts group, click on a chart type then click OK. 
· Once the chart has been created, select the chart area and then the Design ribbon which will allow you to apply a preset format to your chart via the Chart Styles buttons.

Note: Any changes or rearranging of field values in the PivotTable will automatically be reflected in the PivotChart and vice versa.
For information on how to create a PivotChart from scratch, please see the downloadable reference material.

Unit 4 Practice Activity

1. Open the Daily sales.xlsx in the Practice Files folder and select the Pivot Table sheet.

2. Click anywhere in the data area.

3. Create a Pivot Table on a separate worksheet.

4. Change the PivotTable layout to the Classic layout.

5. Rename the sheet tab as My pivot sheet.
6. Drag over the fields of your choice from the Pivot Table Field List to the pivot table area.
Try rearranging and removing fields from the pivot table area.

7. Save as My_Daily_sales.xlsx and close.
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Unit 5: Using ‘What-If’ Analysis Tools
In this unit, you will learn how to:
· Create and view different scenarios

· Use the Goal Seek utility
· Use the Solver utility

Using Scenarios in Excel
In business, it is often beneficial to explore multiple scenarios for a given situation to see what combination of factors gives the best results. With Excel 2007 you can easily explore multiple scenarios based on the same worksheet layout.

In Excel, a scenario can be described as a set of cell values that is saved and substituted into your worksheet as required. If you have multiple scenarios saved, you can load different scenarios into your worksheet and compare and contrast them to see which one gives the best results. You might use scenarios to represent different budget options, evaluate different financial forecasts, or to compare different data projections based on a number of factors. 

Creating a Scenario

When you are creating scenarios for a worksheet, it is a good idea to create a base scenario with the actual or current data for the worksheet and name it appropriately. This way, when you are exploring the scenarios you have created, you will always be able to return to the original (or actual) data.
To create a base scenario in Excel:

· Select the Data Ribbon, Data Tools group, click the What–If-Analysis button and select the Scenario Manager
· Click the Add button to display the Add Scenario dialogue box
· Enter a name for your scenario in the Scenario Name text box 
· In the Changing Cells text box, select the cells whose values will be changing with your mouse (limited to 32 changing cells)
· You can also add some remarks describing the scenario in the Comment area of the dialogue box if you wish. Click OK to show the Scenario Values box.
· Click OK to return to the Scenario Manager Dialogue box.

To create a second scenario to compare with the base scenario

· Click the Add button to display the Add Scenario dialogue box
· Enter a name for your new scenario in the Scenario Name text box
· Click the OK button to show the Scenario Values box. Here you will see a series of text boxes labeled with the cell references for the corresponding changing cells. In each text box, you should enter the appropriate value/s for each cell reference of this new scenario.
· Click the OK button to create the scenario.

To view a scenario:

· Select the Data Ribbon, Data Tools group, click the What–If-Analysis button and select the Scenario Manager
· Select a scenario from the Scenario Manager

· Click the Show button to see the results of the given scenario in the spreadsheet.

For information on creating a scenarios summary report, please refer to the downloadable reference material.

Using Goal Seek
Goal Seek is another useful what-if analysis tool provided by Excel. With Goal Seek, you can set a formula to a value (goal) that you would like to attain, and then specify one of the cells that the formula references as a cell that Excel can adjust in order to reach the goal. 

To use Goal Seek:

· Select the cell that contains the formula that you wish to set to a certain value (goal)

· On the Data Ribbon, Data Tools group, click the What-If Analysis button and select the Goal Seek option

· The selected cell is entered into the Set Cell text field automatically

· In the To Value text field enter the value/result you want Excel to adjust the Set Cell to
· In the By changing cell text field, select the cell which contains the formula input you want Excel to adjust to reach your goal

· Click the OK button

· The Goal Seek Status box reports that a solution has been found.
· Clicking the Cancel button will restore the original worksheet values; clicking OK will enter the Goal Seek solution values into the worksheet.

Using Solver

Sometimes, when dealing with more complex problems, the Goal Seek feature cannot provide the kind of forecast or analysis you are looking for. In this type of situation, Excel 2007’s Solver feature might be able to help. 

The Solver is an Excel feature that is designed for optimising systems of equations subject to specific constraints. The Solver can be used to find optimal solutions for linear programming problems involving multiple equations and multiple unknowns. An optimal solution might be one that maximizes profit, or it could be one that minimizes costs. Basically, the optimal solution will depend on the context of the situation and what you are looking for.

Checking Solver Installation

First, since Solver is an Excel add-in, it may not yet be installed. You can check this by clicking the Data tab to display the Data Ribbon. You may see the Solver button to the far right of the ribbon, in the Analysis group.
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If there is no Solver option, the Solver has not yet been installed.

To install the Solver:

· Display the Office menu and click the Excel Options button.
· Choose Add-Ins from the panel on the left

· Use the drop list at the bottom to specify Excel Add-ins.
· Click Go to display the Excel Add-ins.
· Put a check next to the Solver Add-in option in the available add-ins list

· Click OK. When Excel finishes installing the Solver, you should be able to access the Solver option on the Data Ribbon.

Setting Solver Parameters

To use the Solver:

· Select the Data Ribbon, and from the Analysis group, click the Solver button

· Place your cursor in the Set Target Cell text box

· Click on the worksheet cell that contains your objective formula 
· Select Max, Min or Value of, depending on how you wish to optimise the value of your objective formula; and enter the max/min/exact value
· To enter the changing cells, place your cursor in the text box under the By Changing cells heading, and select the appropriate cells from the worksheet with your mouse. If they are non adjacent cells, press the Ctrl button when selecting them.

· Add any constraints by clicking the Add button to the right of the constraints area. This will display the Add Constraint box.

· Click OK to enter the constraint into the Solver Parameters dialogue box
· Click the Add button again and follow the same process to enter the cell references for the rest of the constraints, if necessary

· To implement the Solver, click the Solve button
· You can create several scenarios, each of which can be saved after you have clicked the Solve button.

For information on creating data tables, another ‘what-if’ analysis tool, see the downloadable reference material.

Unit 5 Practice Activity
1. Open Analytical options practice.xlsx in the Practice Files folder
2. Activate the Solver worksheet.  Use Solver to calculate a total profit of 30% by adjusting the values for Total sales, Cost of sales, Overhead and Marketing.  When adjusting values, you must ensure that the total overhead for the year can not be greater than $25,000 and the net profit for the year must be at least $100,000.  
3. Save the file as My Analytical options practice.xlsx and close the workbook.

Online support forum and knowledge base
www.microsofttraining.net/forum

Visit our forum to have your questions answered by our Microsoft qualified trainers.
Unit 6: Macros
In this unit, you will learn how to:
· Record and run a macro
· Assign shortcut keys to run a macro

What is a macro?

A macro can be described as a tiny program that uses Visual Basic code to automate a sequence of actions or instructions. A macro can be simple and consist of only a few tasks or commands, or be quite complex, involving lots of data manipulation and calculations.

Simple macros are great for any long sequence of keystrokes that you find yourself repeating often, or for combinations of basic Excel actions that would be convenient to automate for a particular workbook. 
Creating a macro
As mentioned preciously, Excel will record the actions you take when creating a macro and convert them into Visual Basic code. This code contains all of the instructions that Excel needs to execute your macro.
The Developer Ribbon
It is not difficult to create a macro in Excel 2007, but first, you should make sure that the Developer tab is accessible.

If the Developer Ribbon is not showing:

· Select the Office menu

· Click the Excel Options button then click the Popular option on the left of the Excel Options window.

· Under the Top Options for working with Excel option, select the checkbox for
Show Developer Tab in the Ribbon. 
· Click OK 
Recording a macro
It is a good idea to plan out or even practice the sequence of actions for your macro before you record it. This will not only ensure that the actions lead to the expected outcome, but also help you to avoid mistakes and unwanted actions in your macros. This is especially true for long macros that require several actions. Remember, once a Macro has been run, you cannot undo it using the Undo button.
To record a macro:

· Select the Developer ribbon

· Click the Record Macro button in the Code group.
Or

· Select the View ribbon

· Click the drop-down arrow of the View Macros button in the Macros group
Or

· Click the Record Macro button on the Status bar, at the bottom left of the Excel screen.


[image: image32]
· Give your new macro a name (do not use spaces) and choose the location where it should be stored.

· You can also enter a brief description of the macro you are about to create in the Description text area.

· Click OK, and Excel will start recording your macro

· When you have finished creating your macro, click the Stop Recording button on the status bar.
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Playing a Macro

To play a macro:

Click the Macros button on the Developer Ribbon. When you click this button you will see the Macro dialogue box.
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Here you can see the macros available for use. Note that macros saved in the personal macro workbook will have Personal.XLSB! in front of their name (such as the macro selected in the list). 

To play the selected macro, click the Run button. To view or edit the Visual Basic code for the selected macro, click the Edit button. To delete the selected macro, click the Delete button. 

When you click the Run button, the Macro dialogue box will disappear, and the sequence of instructions that was recorded in the macro will be performed on the current workbook.

Note: You can see the macros from this workbook and from the personal macro workbook because the “All open workbooks” option is selected in the bottom drop list of the macro dialogue box. If you select the “This workbook” option from the list, or the “Personal.xlsb” option, only the macros corresponding to the specific option you select will be shown.

Macro Security

It is well known that VBA macros can be a source or carrier of computer viruses. Because of this, you should never use a macro if you do not know where it came from, and you should never open a document that contains a macro unless you trust the source of the document.

If you click the Macro Security button on the Developer tab you will see an Excel Trust Center window open to display a list of options for macro security.
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You can also display these options by first clicking the Excel Options button on the Office menu, and then choosing the Trust Center option followed by the Trust Center Settings button.
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Under the Macro Settings heading, you have four options to choose from:
Disable all macros without notification

This setting will prevent macros in files that are not in trusted locations from being run. (Trusted locations are normally on your own hard drive or shared folders on your network.) If you select this option, macros that are not in a trusted location will be disabled. Any alert boxes or messages associated with macro security will also be disabled.
Disable all macros with notification

This is Excel 2007’s default macro security setting. With this setting, macros in files that are not in trusted locations will be disabled, but you will still see security alerts if a workbook from a non trusted location contains a macro. 
This means you will have the option of choosing to allow or not allow the macro to run.
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Notice how the security alert appears below the ribbon. If you click the Enable Content button, the following dialogue will appear. To enable the macro, click the “Enable this content” radio button and then click OK.
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Depending on your Trust Center settings, you may see a warning dialogue when you open a workbook containing a macro.
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Once again, clicking the Enable Macros button will allow you to run the macro.

Disable all macros except digitally signed macros 

If you choose this setting, Excel will basically behave in the same way as it does when you choose “Disable all macros with notification.” The only difference is that if the macro is digitally signed by a publisher that is trusted, you will be able to run the macro. If a macro is digitally signed but the publisher is not trusted, you will then have the option to either enable the macros or to trust the publisher. Any macro that is not digitally signed will not be allowed to run.
Enable All Macros
This is the weakest macro security setting available. If you use this setting, a macro from any workbook can be run, even if it is not in a trusted location and it is not digitally signed. Because of the risks associated with running unknown macros, use this setting with caution.
To set the macro security level, select the radio button corresponding to the level of security that you want and click the OK button in the lower right of the Trust Center window.

To digitally sign a macro, click the Developer tab to display the Developer Ribbon and then click the Visual Basic button to launch the Visual Basic Editor.
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In the tool bar at the top of the Visual Basic Editor’s window, click the Project Explorer button. 
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In the navigation panel on the left of the editor window, highlight the VBA Project/Worksheet containing the macro you want to sign, and then click the Digital Signature option from the Visual Basic Editor’s Tools menu.  
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This will display a Digital Signature dialogue box.
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Click the Choose button to display a list of available certificates. When you are finished, click the OK button. 

More Macro Tasks

Once you get comfortable recording some basic macros, you can begin to explore some additional macro related features and tasks. 

In this lesson, you will learn how to record a relative reference macro, how to assign a keystroke to a macro, and how to copy a macro from another workbook or template. Finally, you will learn how to delete workbook macros.

Recording a Relative Reference Macro

By default, macros employ absolute cell referencing. This means that a macro’s actions are performed on the same cells every time the macro is run. If you specify relative cell referencing for a macro, the actions performed by the macro will be relative to the active cell when you start the macro. This means that the macro can perform actions on different cells each time it is run, depending on what cell is used as the starting point.
To record a relative reference macro, choose your active cell and click the Use Relative References button before you begin recording.
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Once you click this button, simply click the Record Macro button as before to create the actual macro. When you stop the macro recording process, all of the cells that were involved in the macro will be treated as having relative references.

Let’s say, for example, that the active cell is B1 and you create a relative reference macro that shades the cell C1 in blue. If you make cell K10 the active cell and run the macro, cell L10 will be shaded in blue. If this were an absolute reference macro, cell C1 will become shaded in blue no matter what the active cell is when you run the macro.

Running a Relative Reference Macro
To run a relative reference macro, first make sure that the active cell is chosen such that the cells that you want the macro to run on are in the correct relative position.

As an example, suppose that you created your relative reference macro with A1 as the active cell. The macro that you created changes the column of six cells immediately below A1 (A2:A7) to accounting format.
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Here is the data after recording the macro.
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Now, if you wanted to convert cells H3:H8 to accounting format, first pick cell H2, which is in the same relative position to H3:H8 as cell A1 was to A2:A7.
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Now, click the Macro button and choose the correct macro from the Macro dialogue box and click Run.
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Assigning a Keystroke to a Macro
When assigning macro shortcut keys, keep in mind that if the shortcut already has a task associated with it, the macro will now override the original purpose of the shortcut. For example, assigning Ctrl + N as a shortcut for a macro will disable Ctrl + N as a shortcut for opening a new workbook.

There are two ways to assign a shortcut key to a macro. You can assign a shortcut key when you are first recording your macro or you can assign a short cut key to an existing macro.

To assign a shortcut to a macro when you record it, click the Record Macro button on the Developer Ribbon. When you see the Record Macro box, just enter a letter in the Shortcut Key data field.
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Here you can see that the letter d has been assigned as a shortcut key for this macro. Once the macro has been recorded, pressing Ctrl + d will run it. This avoids the process of picking a macro from the Macro dialogue box every time you want to run it. If you press Shift + D when you enter the shortcut key, the shortcut will then become Ctrl + Shift + D for the macro. 

If you store the macro in the personal macro workbook, the shortcut will be carried with it wherever you use the macro.

To assign a shortcut to an existing macro, click the Macro button to display the Macro dialogue box. In the Macro dialogue box, select the name of the macro you want to assign a shortcut key to and then click the Options button.
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This will open the Macro Options dialogue box for the macro you selected.
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There is a small data field that can be used to enter a shortcut key for this macro. You can enter a letter or use a Shift key/letter combination as before. If you click OK, the shortcut key will be assigned to the macro. 
Copying a Macro from a Workbook or Template
If you have an existing macro in a macro enabled workbook or a macro enabled template and you would like to use that macro in another workbook, you can copy the macro from the source workbook or template into the workbook of your choice. 
First, you must use Excel to open the template or workbook containing the macro, as well as the workbook that you are copying the macro into. When both workbooks are open, select the Developer tab on the destination workbook and click the Visual Basic button to display the Visual Basic Editor.
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When the Visual Basic Editor opens, you will see all of the currently open workbooks in the Project Explorer panel on the right.
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(If you cannot see the Project Explorer panel, click the Project Explorer button in the Visual Basic Editor Toolbar.)
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When you record a macro for a workbook, it will be contained in a code module shown in the Visual Basic Editor. In the image shown above you can see that Book3 (the destination workbook) has no modules, but the other open workbooks and templates (macTemplate.xltm and sourcebook.xlsm) have module folders with them. 

To copy a macro from a template or a workbook, open the module folder for the workbook or template that you want to copy from by clicking on the plus (+) sign corresponding to the folder.

In the following image, the modules folder for macTemplate.xltm has been opened.
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To copy the macro from macTemplate.xltm to Book3, just select and drag Module1 from the open Modules folder up to the Book3 area (drag until you see your mouse pointer turn to a plus (+).
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Now, both Book3 and macTemplate.xltm have code modules associated with them.

If you double click on the Module1 icon under Book3 and double click on the Module1 icon under macTemplate.xltm, you will see code windows for both modules (and the macros contained in the modules) open in the editor.

If you examine the VBA code for both modules (macros) in the editor window, you will see that they are identical.
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If you save Book3 as a macro enabled workbook, the process of copying the macro will be complete!

Unit 6 Practice Activity

1. Open Macros practice.xlsm in the Practice Files folder
2. This file contains only one worksheet called Macros. The worksheet has two scenarios: Original and Cost of sales.

3. Create a macro named Display_cost_of_sales that has Ctrl+Shift+C as its shortcut key.  This macro should show the Cost of sales scenario.

4. Create a macro named Display_original that has Ctrl+Shift+O as its shortcut key.  This macro should show the Original scenario.

5. Run the Display_cost_of_sales macro.  Run the Display_original macro.

6. Change the name of the Display_cost_of_sales scenario to Decreased cost of sales.

7. Run the edited macro.

8. Save the Workbook as My macros practice.xlsm and close.
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